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ABOUT THIS TRAINING WORKBOOK

The scope of this workbook is to familiarize you with the main features of SDL Trados Studio 2011. It 
contains practical, real-life examples of how to leverage SDL Trados Studio 2011 to streamline your 
translation processes. This document provides the following:

C General information on CAT technologies

C An overview of the SDL Trados Studio 2011 user interface

C An example of how to translate documents using the most commonly used SDL Trados Studio 2011 
features

C An example of how to process documents contained in a project package

The main focus of this training guide is on practical life examples, for which training sample files are 
available.

We recommend that you copy the sample files to your Desktop, so that you can find them easily.



Chapter

CAT TECHNOLOGIES OVERVIEW

This chapter gives you a quick overview of the CAT 
technologies referred to in this training workbook:

C Translation memories (TMs)

C Terminology databases

C Alignment

C AutoSuggest dictionaries

C Process and workflow overview

It also explains the scope of the two applications referred to in 
this training workbook:

C SDL Trados Studio 2011

C SDL MultiTerm 2011

2
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WHAT ARE CAT TECHNOLOGIES?

CAT stands for Computer-Aided Translation. This term refers to technologies used to streamline translation 
and localization processes. 

Translation Memories
Translation memories (TMs for short) are databases that store source sentences and their translations as 
segment pairs. Note that as not every text element in a document is a full sentence, translation tools refer 
to segments rather than sentences. Usually a segment is a sentence, but it could also be just a few words, 
like the heading Getting Started. The TM ’remembers’ each segment that is translated, and stores the 
source/target segment pairs in the TM database as translation units (TUs). If an identical or a similar 
segment comes up later, it does not need to be translated from scratch. Instead, the translation can be 
easily retrieved from the TM database.

This technology offers two main advantages:

C Faster turnaround times and cost-savings, as repetitive content can be translated much more 
quickly.

C Better consistency and quality: with TM technology you can make sure that you do not translate 
repeated occurrences of the same sentence differently, which can be confusing to readers.

Terminology Databases (Termbases)
Terminology databases (or termbases) are similar to electronic dictionaries. Rather than storing whole 
segments, they contain single words or expressions. Creating and maintaining termbases is useful for 
storing organization-specific, customer-specific or product-specific terms, which cannot be found in 
standard dictionaries. Example: a termbase used for software localization may contain terms such as dialog 
box, dropdown list, taskbar, etc. 

Termbases can be accessed from within a translation environment, e.g. SDL Trados Studio 2011. In this 
case, the source sentences are automatically searched for relevant terminology in the background. The 
corresponding target terms can then easily be inserted into the translation. This process is called active 
term recognition. This saves you the trouble of having to open a separate application in order to do time-
consuming research work. Termbases offer the following main advantages:

C Cost and time savings, as you avoid tedious extra work such as researching and typing long-winded 
expressions.

C Quality increases, as the same expressions are used consistently throughout a document. 
Termbases help you effectively avoid unnecessary variations, which can be confusing to readers.

C You can create and manage terminology that is customer or product-specific and that cannot be 
found in any standard dictionary.
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AutoSuggest Dictionaries
While TMs store whole segments, AutoSuggest dictionaries are used for retrieving segment fragments. 
When you use an AutoSuggest dictionary, it will automatically suggest segment fragments while you are 
typing. For example, when you start typing the letter d, it will suggest relevant expressions that fit the 
current context, e.g. distribution pattern of centipedes. 

AutoSuggest dictionaries are created from translation memories. SDL Trados Studio 2011 offers a wizard 
that allows you to select a given TM for creation of an AutoSuggest dictionary. A sophisticated algorithm 
analyzes the TM for useful words, expressions and phrases, which can later be automatically suggested 
while typing. 

NOTED
The Freelance Edition of SDL Trados Studio 2011 allows you to create AutoSuggest dictionaries for a 
duration of 30 days after installation. Users of the Freelance Edition need to purchase an SDL 
AutoSuggest Creator license to be able to continue creating AutoSuggest dictionaries after the initial 
30 days. The Professional Edition of SDL Trados Studio 2011 has no restrictions when it comes to 
using and creating AutoSuggest dictionaries. 
 
The SDL Trados Studio 2011 Starter Edition does not support the creation or use of AutoSuggest 
dictionaries. 
 
For information on the differences between the three available editions, please refer to 
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2.

Alignment
When you start using a translation memory tool, you will have to fill it with your own translations, as the 
database is empty at the beginning. In order to re-use any translations you have already done, you can use 
the alignment tool to create segment pairs out of two separate documents (source language document and 
translated document). These segment pairs can then be imported into your translation memory. From 
there you can easily re-use your previous translations.

http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
http://www.translationzone.com/en/products/sdl-trados-studio/#tab2
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Process and Workflow overview with SDL Trados Studio 2011
The following diagram summarizes the translation workflow and processes within SDL Trados Studio 
2011. It shows how the different databases are used in the translation workflow. 
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Applications Overview
Below you find an overview of the two applications referred to in this training workbook.

SDL Trados Studio 2011

SDL Trados Studio 2011 is the application that this training workbook focuses on. It provides the following 
main functions in an integrated user interface:

C Translation memory capability

C An editing environment for translating and reviewing various source document formats such as 
Microsoft Office, Desktop Publishing, like Adobe InDesign, tagged formats like XML, HTML, etc.

C Automatic quality assurance features

C Functionality for creating and managing projects

This training workbook focuses on the most common functionality for translating documents quickly and 
efficiently in SDL Trados Studio 2011.

NOTED
There are currently three different editions of SDL Trados Studio 2011 available: the Professional, 
Freelance and the Starter Edition. For information on the differences between these editions, please 
refer to http://www.translationzone.com/en/products/sdl-trados-studio/#tab2.

SDL MultiTerm 2011

SDL MultiTerm 2011 was designed for searching, editing, creating, and maintaining terminology 
databases. This Getting Started training workbook focuses on how to use terminology in the translation 
process. Note that the Getting Started course only contains some basic information on how to use 
MultiTerm, it does NOT include a detailed course on terminology and SDL MultiTerm 2011. SDL 
MultiTerm 2011 is extensively covered in dedicated courses for translators and project managers.

http://www.translationzone.com/en/products/sdl-trados-studio/#tab2


Chapter

THE SDL TRADOS STUDIO 2011 
ENVIRONMENT

This chapter provides a quick overview of the SDL Trados 
Studio 2011 user interface. You will learn how to:

C Start the application for the first time

C Select a user profile

C Handle the user interface

3
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INITIAL STARTUP OF THE APPLICATION

After installation, start SDL Trados Studio 2011 by clicking the corresponding application icon. To do this 
take the following steps:

1. Select the program group All Programs -> SDL -> SDL Trados Studio 2011 and click the SDL Trados 
Studio 2011 application icon.

2. When starting the application for the first time, you need to activate the product. To do this 
click the Activate button.
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3. Enter or paste the activation code that you have received into the Activation code text field, 
then click the Activate button again.
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NOTED
You may use alternative activation options (e.g. a license server) if applicable. If this is the case, click 
the Alternative activation options link, which will open the window shown below. Select the activation 
option that is relevant for you and follow the instructions on the screen.
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4. After successful activation of the product the setup wizard of SDL Trados Studio 2011 will 
open. On the welcome screen just click Next.

5. On the Current User Details screen The Name text field should already be pre-filled. Enter 
your e-mail address, which is mandatory information. Then click Next.
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6. You can leave the Default setting on the User Profile unchanged and click Next to continue.

7. Deselect the Load samples at initial startup option, as the sample project is not required for 
this training course. Then click Finish to finish the setup process.

NOTED
The above steps are only necessary when you open the application for the first time.
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You will now see the Home screen of SDL Trados Studio 2011:

NOTED
The toolbar buttons Software Localization and Terminology Management will only work if the 
corresponding applications (i.e. SDL Passolo and SDL MultiTerm) are installed on your PC. 

The SDL Trados Studio 2011 User Interface

The Home Screen

The Home screen of SDL Trados Studio 2011 provides quick access to commonly used functions:

C Open Document: opens single documents for translation

C New Project: starts a project wizard to prepare one or more files for translation into one or more 
target languages (this functionality is not covered in Getting Started, but in the Intermediate course)

C Open Package: opens a project package sent by a project manager for translation or editing; this 
button can also be used by project managers to open return packages that were sent back by 
translators or reviewers

C Open Server Project: allows access to an online project on a server where several users can work 
together in one project at the same time.

The Navigation Pane

The Navigation pane on the left-hand side features links to popular help topics. Below the help topics you 
find links to latest news items (if an Internet connection is available).
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On the bottom of the Navigation pane you find a set of buttons: Home, Projects, Editor, Translation 
Memories. By clicking these buttons you can switch between different views. During this training course 
we will mainly work in the Editor view, which is used to translate, edit and review documents.

NOTED
The content of the Navigation pane changes when you switch to a different view. For example, in the 
Editor or Projects view it offers different functions than in the Home view. In the Editor view it offers 
functions relevant for editing and navigating documents, in the Projects view it contains functions 
relevant for managing projects.

The Application Toolbar

On the top of the application window you will find the application toolbars with buttons, which provide 
access to common functions such as Open Document, Open Package, New Translation Memory, etc. Apart 
from that you will find buttons used to access more advanced functions such as Align Translated 
Documents.

Optimizing your Screen Space

You can minimize the Navigation pane on the left-hand side by clicking the Minimize the Navigation Pane 
button. When minimized, the links to help topics and the navigation button labels are no longer visible. 
However, the navigation buttons on the bottom of the Navigation pane will still be accessible.

With the keyboard shortcut F11 you can switch to the Full Screen mode. This will hide elements such as 
the top application bar. By pressing F11 again you can exit the Full Screen mode.

These tips can be helpful especially for users with small screens, e.g. if you are working with a notebook.

FOR MORE INFORMATION
V

C Overview: Introducing SDL Trados Studio 2009

C System Requirements

C Introducing the Views

C Overview: Screen Layout and Functionality

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Introducing/inintroducingsdltradosstudiooverview.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Introducing/System_Requirements.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Introducing/inintroducingsdltradosstudiointroducingtheviews.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Overview___Screen_Layout_and_Functionality.htm


Chapter

CREATING A TRANSLATION 
MEMORY

In this chapter you will learn how to create a new translation 
memory database. We will use this database for translating a 
sample document.

4
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CREATING A TRANSLATION MEMORY

To create a new translation memory (TM) database take the following steps:

1. On the Home screen of SDL Trados Studio 2011 click the New Translation Memory... button.�

2. In the Name text field of the New Translation Memory dialog box enter the name of your TM. 
It is good practice to use descriptive file names for translation memories, which reflect the 
language pair, e.g. EN-DE_Training.

3. The Location text field shows the default path in which the TM file will be stored. The TM 
file will have the extension SDLTM. As you need to select the newly-created TM later for 
translation, we recommend that you specify a location that you can find easily, e.g. your 
Desktop/Sample files.

4. To do this click the Browse button, select your preferred path in the Browse For Folder dialog 
box, and confirm with OK.

5. Make sure that English (United States) is selected in the Source Language dropdown list. 

6. From the dropdown list Target Language select German (Germany).

NOTED
The sample documents in this course are in English. Therefore it is important that you select English 
as the source language. Some of the examples use German as a target language, so we recommend 
that you also use German in this training course. 

7. There are some more options when you set up a TM, but for this course, we only need the 
basic settings. Click the Finish button to create the TM.

8. On the following page a progress bar will indicate when the TM creation is completed. 
When this is the case, click the Close button.
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FOR MORE INFORMATION
V

How to create a local translation memory

Note that SDL Trados Studio 2011 has switched to the Translation Memories view. Since the newly-created 
TM is empty, there are no translation units (TUs) to display. In the following chapter you will learn how 
you use this TM for translation.�
�

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/TM_View/Cre-Man_TM/TMCreate_a_New_Translation_Memory.htm


Chapter

TRANSLATING SINGLE FILES

This chapter provides an example of how to translate a simple 
Microsoft Word document from English into your preferred 
target language. You will learn how to:

C Open a source document and selecting the language 
direction

C Select language resources: translation memory and 
AutoSuggest dictionary

C Navigate in the Editor

C Use matches from the translation memory

C Look up words and expressions through a concordance 
search

C Correct spelling mistakes

C Apply character formatting

C Track your translation progress

C Preview the document in its native format

C Generate the target document in its native format 5
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OVERVIEW

When you only have one file to translate, you can open the file directly in SDL Trados Studio 2009, the 
system will create a project for your file automatically. But even though a project is created, there are 
differences between translating a single file and setting up a project with the project wizard. The project 
of a single file is limited to this file, new files cannot be added to the project.

Then you choose which translation memory and termbase you want to use. 

For translation, your file will be saved into the internal SDLXLIFF format. This file will contain source and 
target language sentences while you translate.

After translation you save your translated file back to the original file format.

OPENING A FILE

To open the sample document for translation, take the following steps:

Selecting the Document and the Language Pair
1. Click the Open Document toolbar button on the top of the application.�

2. Browse to the sample files folder in which the sample document is located, e.g. ..\Sample 
Files\Translating Single Files.

3. Select the file sample.doc by double-clicking it.

4. In the Open Document dialog box, make sure that English (United States) is selected as the 
source language.

NOTED
The source and target languages you select here need to match the language pair of the translation 
memory that you created in the previous chapter (i.e. EN-US_DE).

5. Select your target language from the Target Language dropdown list, i.e. German (Germany).
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Selecting a Translation Memory
1. Add your recently created TM by clicking Add -> File-based Translation Memory.

2. Browse for your TM file, i.e. EN-DE_Training.sdltm, and double-click the file to add it.

3. The selected TM should now be displayed as shown below:�

4. Make sure that all four checkboxes are selected, to be able to use this TM for this translation 
(enable), to get segment lookup, to get lookup of segment parts (concordance9 and to save 
your translations to this TM (update)
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Selecting an AutoSuggest Dictionary
1. Click the Advanced button to add a sample AutoSuggest dictionary and a termbase. This will open 

the Project Template Setting dialog box.

NOTED
Remember that translation memories allow matching on a sentence (segment) basis, while 
AutoSuggest dictionaries are used for matching segment fragments.

2. Click AutoSuggest Dictionaries on the bottom of the tree on the left-hand side of the dialog 
box.Click the Add button in the lower right corner of the dialog box.

3. Select the AutoSuggest dictionary for your language combination by double-clicking the file, 
e.g. ..\Sample Files\AutoSuggest\AutoSuggest_EN-US_DE-DE.bpm.

Selecting a Termbase
1. Next, select the sample termbase. To do this click All Language Pairs, and then select Termbases.

2. Click the Add button to open the Select Termbases dialog box. Here, you need to click the 
Browse button.

3. Browse to the Termbase folder of your sample file set (e.g. ..\Sample Files\Termbase) and 
double-click the termbase file Sample.sdltb. 

4. The termbase name should now be displayed in the Select Termbases dialog box. Note that 
the check box next to the termbase name needs to be selected, which is already done by 
default.�
Close the Select Termbases dialog box by clicking OK.

5. An information message appears, which you simply close with OK.

6. Click OK again to open the sample source document in the Editor view.
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NOTED
Term bases can contain several languages, this is why they are selected in the area All Language 
Pairs, while AutoSuggest dictionaries are always specific to one language pair, therefore you add 
them in the section of this specific language pair.

FOR MORE INFORMATION
V

How to Add an AutoSuggest Dictionary File for a Language Pair

TRANSLATION EDITOR OVERVIEW

The Editor view presents a side-by-side view of the document:

The source document is displayed in a table, with each sentence (commonly referred to as segment) is 
displayed in a table row. The table has five columns:

1. The first column shows the segment number, by which each segment can be uniquely referred to.

2. The second column shows the source segments.

3. The third column shows the segment status. It contains icons indicating the translation 
status and the translation origin. Here, you can ascertain at a glance whether a translation is 
in draft status, is confirmed, etc. In the beginning, all cells in this column contain a white 
icon, which indicates that all segments are currently untranslated. 

FOR MORE INFORMATION
V

Segment Status Column (Side-by-Side Editor)

4. The fourth column shows the target language. This is where you enter the translations of 
the corresponding source segments.

5. The fifth column shows the document structure information. Here, you can see whether a 
segment is e.g. a heading, a footnote, normal paragraph text. For example, the first segment 
is a heading which is indicated by letter H. Move the mouse pointer over the H in this cell. 
This will display a tooltip with the full description, i.e. Heading. Move the mouse pointer 
over one of the cells below, which contain the letter P. This will show a Paragraph tooltip.

FOR MORE INFORMATION
V

Overview: Side-by-Side Editor Components

The Windows in the Editor
Above the side-by-side editor, you see a number of tabs, most importantly the Translation Results window. 
This is where matches from the TM (if any) are displayed. For the first segment in our sample document 
the message No matches found is displayed, as the TM does not contain a match for the current segment.

Note that the window actually consists of a number of tabs. By clicking the tabs you can switch between 
different windows, e.g. Translation Results, Messages, Concordance Search, and Comments. In the course 
of this exercise you will get to know the function of each tab.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Setting_Preferences/AutoSuggest/Add_Phrase_Mapping_Bilingual_File.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/Segment_Status_Column.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/SbS_EditorCom.htm
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Each source language sentence (segment) you are going to translate is compared to all source language 
segments in the TM. If a similar segment or the same segment is found, the translation saved with this 
segment will be shown as a translation suggestion. The comparison between the segment to translate and 
the segment in the TM is called „matching”. If you see a suggestion for a translation, a match for the 
source language segment was found in the TM, i.e. the translation from the TM might be useful for the 
translation you have to do now.

For the first segment in our sample document the message No matches found is displayed, as the TM is 
still empty does not contain a match for the current segment.

In the course of this exercise you will get to know the function of each tab (Translation Results, Messages, 
Concordance Search, and Comments).

FOR MORE INFORMATION
V

Overview:  The Editor View Windows 
Translation Results Window

Next to the Translation Results window you find the Term Recognition window, which displays hits from 
the selected termbase(s). 

FOR MORE INFORMATION
V

Term Recognition Window

You can close, resize, and rearrange all windows to leverage your screen space as required. Try to perform 
the steps below on the Term Recognition window:

C Closing windows: Click the Close (X) button in the upper right corner of the window to close it. 
Instead of the Term Recognition window, the Termbase Search window is displayed, which you can 
close as well. To re-open both windows select the View -> Termbase Search and View -> Term 
Recognition menu commands.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/EVTheEditViewWindowsOverview.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/TermRecWin.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/EVTheEditViewWindowsTranslation_Memory.htm
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C Auto-hide windows: You can auto-hide windows by clicking the Auto Hide button in the upper right 
corner of the window. �

If the Auto Hide button is pointing to the left, the window automatically collapses once you move 
the mouse pointer away. �

�
The name of the hidden window (e.g. Term Recognition), however, will still be displayed in a tab. �
�

When moving the mouse pointer over the tab, the window will reappear. If you move the mouse 
pointer out, the window will hide again. You can disable Auto Hide and fix the position of the 
window by clicking the Auto Hide button once more. When the Auto Hide button icon is pointing 
down, the window stays locked in its current position.�

C Moving and docking windows: You can move and rearrange windows within the application or even 
drag the window and position it outside of SDL Trados Studio 2011. For example, you can move a 
window to a second screen. To move a window:

C Move mouse pointer over the title bar of the window and press the left mouse button.

C With the left mouse button pressed, start moving the window to another position. (You can 
also move it to a position outside of the application window.) 

C While you are dragging the window direction indicators will appear on your screen. To dock 
the window, for example, to the right border of SDL Trados Studio 2011, move your mouse 
pointer (with the left mouse button still pressed) over the direction indicator pointing to the 
right and release the left mouse button.

C The window is now docked on the right-hand side of SDL Trados Studio 2011.

C Resetting the window layout: You can always reset the windows layout to the default setting by using 
the menu command View -> Reset Windows Layout.

Navigating in the Editor

Moving from Segment to Segment

You can easily move to the next or previous segment to translate or edit in the Editor simply by using the 
Up/Down Arrow keys on your keyboard. Of course, you can also click inside a segment to select it. The 
selected segment will then be highlighted.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/TM_View/TM_Displaying_and_Managing_Windows.htm
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Navigating in the Document Tree

The document tree in the Navigation pane on the left-hand side allows you to quickly jump to a particular 
section in the file. The sample documents contains three main sections. The section headlines are shown 
in the document tree. For example, to jump to the second headline simply click the link Segments with 
Formatting in the document tree. The corresponding segment in the document will then be selected.

Now click the first link in the document tree, i.e. Simple Segments. This will lead you back to the first 
segment.

FOR MORE INFORMATION
V

The Editor View Navigation Pane

Translating the First Segment
In the target column enter the translation for the first segment, e.g. Einfache Sätze. 

NOTED
The letter H in the last column on the right-hand side indicates that this segment is a heading.

Note that as soon as you start typing the translation the icon next to the segment changes to the following 
symbol, which indicates that this segment has been edited:

Note that this symbol also indicates that this segment is still in draft status, and has not been confirmed 
and added to the TM yet.

Using AutoSuggest

Use the Down key on your keyboard to move to the following segment (This is an example of a new sentence). 
Example for a German translation: Dies ist ein Beispiel für einen neuen Satz. Note that as soon as you start 
entering the translation for the word example, the application suggests the corresponding translation, i.e. 
the German word Beispiel).

NOTED
There will be further examples of hits from the AutoSuggest dictionary, which you can insert into your 
translations.

Instead of typing the whole word, just press the Enter key on your keyboard to insert the suggestion. Then 
go on by completing your target segment. Confirm the translation and save it to your TM by pressing the 
key combination Ctrl+Enter. Observe that icon between the source segment and your translation changes 
to the following:

This icon indicates that your translation has been confirmed and saved to your TM.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/EVScreenLayoutandFunctionalityThe_Navigation_Pane.htm
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Auto-propagating Translations
The moment you have confirmed the second segment two things happen:

Row 6 is a repetition of the second sentence, which you have just translated. By confirming segment 2, 
your translation has been automatically inserted into segment 6, which is identical to segment 2. This 
feature is called Auto-propagate. It means that whenever you translate or edit one instance of a segment 
that is repeated within your document, all other occurrences of the same segment will be updated 
accordingly.�
Note that the icon next to the translation in row 6 has been changed to the following:

1. This symbol indicates that this segment is 100% identical (i.e. an exact match) to the segment from 
row 2, which you have previously translated and stored in the TM.

Moreover, row 3 now also contains a translation suggestion. The segment is similar to the one in row 2, 
which you have translated and added to the TM. Between the source and target segment you will see the 
following icon:

2. The icon indicates that a translation has been automatically suggested from the TM, but it 
has not been confirmed. Moreover, the 92% match icon shows that this is not an exact 
match, as segment 3 is only similar to a previously translated segment. In the above example 
the degree of similarity is 92%. This means that you need to adapt the suggested translation 
before you confirm and save it to the TM.

FOR MORE INFORMATION
V

C About Translation Memory Lookups

C About Translation Memory Matches

Editing a Fuzzy Match
When you get a suggestion for an identical segment, we talk about a 100% or exact match. Whenever there 
is a match rate below 100%, this is called a fuzzy match. Take a look at the Translation Results window 
above the document. This window highlights what the differences are between the segment in the 
document and the similar segment from the TM and helps you to determine which changes you need to 
make to the suggested translation.

In the Translation Results window you will find three segments:

1. At the top of the window you see the current segment from the document. 

2. The segment below it is the source segment retrieved from the TM. Differences between the 
segment from the TM and the currently active segment from the document are highlighted 
with strikethrough and underline formatting. In the above example the word an has been 
replaced by another. Note that words that have been removed (e.g. an) are highlighted with 
red strikethrough formatting. Words that have been added (e.g. another) are highlighted with 
blue-green underline formatting.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTranslationMemoriesAbout_Lookups.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTMsAbout_Translation_Memory_Matches.htm
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3. On the right-hand side you find the translation for the segment retrieved from the TM, 
which has also been inserted into the document as a suggestion.

Edit the suggested translation as required by the current source context.

When you edit translations suggested from the TM, the translation origin icon (which shows 92%) becomes 
transparent (see example below). This indicates that a translation has been suggested from the TM, but a 
human translator has modified it.

Spell Check as you Type
If you misspelled a word in the translation this will instantly be highlighted with a wavy red line.

Correct spelling mistakes as follows:

1. Right-click the incorrect word.

2. This opens a context menu with one or more suggested corrections.

3. Pick the appropriate suggestion from the context menu to correct the spelling mistake.

Press Ctrl+Enter to confirm and save the modified translation to the TM and to go to the next segment.

FOR MORE INFORMATION
V

C How to Check Spelling As You Type

C How to Enable/Disable Check Spelling As You Type

NOTED
You can also run a spell check on the entire document (i.e. after you have completed the translation) 
through the menu command Tools -> Check Spelling. Any spelling suggestions will then be shown for 
selection in the Spell Checker dialog box.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/EVCheck_Spelling_As_You_Type.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/EVCheck_Spelling_As_You_Type.htm
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Automatic Number Substitution
Now translate segment 4 (You still owe me 200 dollars), and confirm it with Ctrl+Enter. As soon as you 
confirm the following segment will automatically be translated and marked as a 100% match. Note that 
the only difference between segment 4 and 5 is the number, i.e. 200 vs. 1,000.�

Number differences are adapted by SDL Trados Studio 2011 automatically. This is why the next segment 
has been marked as a confirmed 100% match so you do not need to modify the segment manually. Just 
press Ctrl+Enter to continue.

NOTED
Segments may contain elements such as numbers, which are called placeables, as they are ’placed’ 
inside the target segment rather than being translated. Note that placeable elements are marked with 
a blue underline in the source segment.

NOTED
If your segment contains more than one number, check carefully that the numbers in the translation 
appear at the correct position, especially if the translation was retrieved as a 100% match.

Applying Character Formatting
Now translate segment 7, confirm it, and proceed to segment 8:

Note that segments 8 and 9 are almost identical, the only difference is the formatting of the word „many”. 
When you translate segment 8 and store the translation in the TM, SDL Trados Studio 2011 will suggest 
the translation for segment 9. The difference in character formatting is the reason, why you do not get an 
exact match, but a 99% match.

NOTED
TMs do not only take text differences into account, but also character formatting differences.

Modify the suggested translation by applying bold formatting to the target segment:

1. Select the word in the target segment that needs to be formatted (e.g. by double-clicking it).

Click the Apply bold button in the toolbar.

2. The selected word has now been formatted accordingly, and you can press Ctrl+Enter to 
proceed.
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Active Terminology Recognition
Take a look at the next segment. You will notice that two words are highlighted with red bracketed lines:�

These lines are used to highlight words that have been found in the terminology database. If a termbase 
has been selected for a project, the source segments will be automatically scanned for any known 
terminology. This feature is called Active Terminology Recognition. Take a look at the Terminology 
Recognition window in the upper right corner of the application. Note that it lists the recognized source 
terms and their translations.

As soon as you start by typing first letter of the translation for application icon, the system will automatically 
offer the full term, which you can insert into your target segment by pressing the Enter key.

Inserting terminology into your target segments is done in the same way as inserting matches offered by 
the AutoSuggest dictionary. In the above example the list contains suggestions both sources, i.e. the 
AutoSuggest dictionary and the termbase. You can easily distinguish between termbase matches and 
AutoSuggest dictionary matches, as they are marked with different icons. 

Terminology matches have the following icon:

AutoSuggest dictionary matches are marked by the following icon:

NOTED
Termbase suggestions are usually more reliable than AutoSuggest dictionary matches, as termbases 
are maintained by a terminologist or translator.
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Applying Character Formatting Through QuickPlace
To apply formatting to words in the translation, we have already used the usual way of marking the word 
and applying formatting with a formatting button. There is another way to apply the formatting 
information from the source segment to words in the target segment, which is called QuickPlace. It works 
the same way as inserting terms from the termbase or AutoSuggest dictionary.

1. Highlight the words in your target segments to which you wish to apply some character formatting.

2. Press the following keyboard combination: Ctrl+, (comma).

This will open a QuickPlace list - with the three types of character formatting that are used in the source 
segment - and which allows you to apply character formatting quickly by using simple keyboard 
commands.

3. Select the required formatting and press Enter on your keyboard.

NOTED
The available types of formatting are sorted in an intelligent manner so that the formatting type that 
is most likely to apply to the selected word(s) is listed first. However, you can select any other 
suggested formatting type from the list by using the Up Arrow and Down Arrow keys on your 
keyboard.

4. Repeat these steps for the other strings in the target segment that need to be formatted, and 
confirm the segment.

Real-time Preview
It is often useful to view the actual Microsoft Word document layout. You can do this any time while you 
are translating:

Move the mouse pointer over the Preview tab on the top right of the application window.

5. The Preview window will slide in. Click the Click here to generate initial preview link in the 
Preview window.

6. This will show the target text in a Microsoft Word preview window.
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TIPE
Depending on your screen size and resolution, the preview may turn out too small to read. You can 
resize the Preview window by moving your mouse pointer over the divider of the left-hand side of the 
window and drag it to the left while keeping your left mouse button pressed.

NOTED
The real-time preview is available for the following file formats: Word, PowerPoint, HTML, and XML. 
All other supported document formats (e.g. Adobe FrameMaker, InDesign etc. can be previewed in 
the native application if installed on your PC).

TIPE
To make sure the text is not cut off, you can select Fit to width from the dropdown list on the bottom 
of the Preview window.

In the Preview window the currently selected segment from the Editor is highlighted with a grey 
background. That way you can quickly ascertain which part of the document you are currently translating. 
You can also click a segment in the Preview. This will select the corresponding segment in the Editor view.

By default the Preview window is set to auto-hide, i.e. it will disappear once you move the mouse pointer 
away from it.

FOR MORE INFORMATION
V

You can keep the Preview window open while you are translating. That way you can see how the 
actual layout changes segment by segment. To lock the Preview window in place, click the Auto Hide 
button, i.e. How to Preview the Translation 

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/Preview_the_Translation.htm
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Inserting Single Tags
Some information in the text will be shown as tags, which are basically placeholders. Tags can appear for 
specific formatting information like subscript or superscript or for elements like footnote or index 
markers. 

Translate and confirm the segment Special Elements (e.g. Besonderheiten), and move on to the next 
segment, which is:

This segment contains a footnotereference tag. 

The text of the current segment identical to another one that you translated previously. However, you need 
to insert the tag into the target segment before you proceed. Otherwise, the footnote reference would be 
missing in the target document. To do this take the following steps:

1. Place the cursor at the position in the target segment where the tag needs to be inserted.

2. Press the keyboard combination: Ctrl+, (i.e. the same one you used previously for applying 
character formatting).

3. This will open a QuickPlace list, which contains a footnote reference tag. Press Enter to 
insert the tag into your target segment.�

4. This will insert the tag into the target segment. Confirm the target segment with Ctrl+Enter 
and proceed.

Concordance Search
In the next segment you find the actual footnote content. The TM does not offer any matching segment 
for this sentence. However, the TM contains the expression access keys, which you have translated in 
previous segments. You can check how access keys was previously translated, by using the concordance 
search feature. A concordance search allows you to select a particular word or expression and look it up in 
the TM:

1. Select the expression access keys in the source segment.

2. Press F3 on your keyboard (or click the right mouse button and select Concordance Search 
from the context menu).
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3. This will display all segment pairs from the TM that contain the selected expression in the 
Concordance tab. In the source segments, the search string is highlighted with a yellow 
background.

NOTED
The concordance search also finds derived and inflected forms of your search string. For example: if 
you select access key, the TM will still find access keys. 

NOTED
The concordance search can also be carried out in the target language. To do this select a string in the 
target language and press F3.

Finish translating this segment, and confirm it with Ctrl+Enter. 

FOR MORE INFORMATION
V

C Concordance Search Window (Editor View)

Tracking the Translation Progress
Before you translate the next segment, take a minute to check on your translation progress. When you edit 
or confirm a segment, the status of the document is updated in the status bar on the bottom of the 
application window:

The status bar indicates the percentage of words in the text that have not yet been translated (about 20%), 
that are in draft status (about 14%), and that have been confirmed (about 67%).

Inserting Tag Pairs
The next segments contains two tag pairs. Tag pairs consist of an opening and a closing tag, which enclose 
in this example a Web address.

To translate this segment take the following steps:

1. First, translate the segment. Just ignore the tags for now.

2. Then highlight the Web address in the target segment.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/Concordance_Search_Window.htm
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3. Move the mouse pointer over one of the csf tags in the source segment. (You can select either 
the opening or closing csf tag.

NOTED
csf stands for change style formatting

4. With the Ctrl key pressed click one of the csf tags.

5. This will insert the csf tags around the Web address in your target segment. Repeat steps 3 
and 4 for the field tag pair and the csf tag pair around the rest of the text.

NOTED
Tags here are placeholders for the beginning and end of formatting information, but they do not 
substitute spaces. Please be sure that you are typing all the spaces your text needs.

Ghost Tags
Tags here are placeholders for the beginning and end of formatting information, but they do not substitute 
spaces. Please be sure that you are typing all the spaces your text needs.

Before moving on to the next segment we would like to introduce the concept of ghost tags. Very often tags 
need to occur in pairs, i.e. an opening tag and a closing tag to start and end some formatting. Deleting a 
closing tag, for example, while leaving the opening tag in the translation is likely to cause problems in your 
target document. For example, character formatting may be applied to words that are not supposed to have 
this type of formatting. SDL Trados Studio 2011 offers an effective way of drawing your attention to such 
problems. Try the following: 

1. Try to remove the last (i.e. the closing) field tag with the Backspace key.

2. Note that the tag is not fully deleted. Instead, it becomes transparent. This is what is called a 
ghost tag. The ghost tag will actually only be removed if you delete its opening counterpart 
as well. Turning tags into ’ghosts’ is a way of warning users that they are missing a tag.

3. To restore the tag that you tried to delete, highlight the ghost tag, and click the right mouse 
button. Then select Restore Tags from the context menu, which will restore the tag pair. 
Confirm the segment with Ctrl+Enter to proceed.

Tag View Options
You can change the way tags are displayed using the corresponding toolbar buttons. Clicking the Full Tag 
Text button will show the entire tag text, for example, the underline style information, the color code, etc.:�
�
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�
Using the No Tag Text button you can minimize the tags as shown below:

Switch back to the Partial Tag Text view by clicking the corresponding button. This is the recommended 
default tag display option, as it shows only the names of the tags (e.g. field), which gives you a good idea of 
what a particular tag stands for.

FOR MORE INFORMATION
V

About Ghost Tags

Automated Translations
The last segment only contains a Web address, which should remain unchanged in the target document. 
The entire source segment is considered a placeable element. This is why it has a blue underline. 

Moreover, the Web address has been automatically inserted into the target segment. The AT icon between 
the source and the (identical) target segment indicates that this is an Automated Translation suggestion. 
SDL Trados Studio 2011 ’assumed’ that the Web address does not need to be localized and translated the 
segment automatically. If the Web address indeed does not need to be changed in the target segment, 
confirm this short segment with Ctrl+Enter. 

Finishing the Translation
You have now translated all segments in the document. Note that the status bar on the bottom of the 
application window indicates that we have not confirmed and committed all segments to the TM.

In the above example about 2% of the text are edited, but not confirmed. Remember that you have not yet 
confirmed the first segment. Place the cursor into the target column of the top row. Imagine you are not 
happy with the way you first translated the first segment. Therefore, make a change to the translation (e.g. 
instead of Einfache Sätze write Simple Sätze). After editing the first segment, press Ctrl+Enter to confirm 
and save it to the TM.

NOTED
At this point you can still edit any of the target segments in the Editor view. By pressing Ctrl+Enter, 
you can reconfirm them and commit the changes to the TM. The previously entered translation will 
then be overwritten with the latest version.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/Tags/About_Ghost_Tags.htm
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Saving the Document 
Now save the document in SDL Trados Studio 2011:

1. Select the menu command File -> Save.

2. This opens the Save As dialog box. In the text field File name the suggested file name is 
sample.doc_en-US_de-DE.sdlxliff. (The actual name depends on your source/target language 
combination, as the language pair is appended to the original document name.

3. Click the Save button to save the document.

NOTED
SDL Trados Studio 2011 saves all documents in the bilingual SDLXLIFF format (i.e. not in the native 
format, e.g. DOC or PPT). SDLXLIFF files contain both languages, the source language segments and 
your translated segments. You will learn how to save your translation back into the original file format 
later.

FOR MORE INFORMATION
V

SDLXLIFF File Format

Generating a Printable WYSIWYG Preview
For proofreading purposes, you might want to create a preview of your translated file:

1. Select the menu command File -> View In -> MS Word as Target.

2. This will open the target document in Microsoft Word. You can use this preview for printing 
and proofreading the document from paper.

3. Please note that any changes you make to this preview document do not go back into your 
translation environment or the translation memory. Any changes have to be made inside the 
Editor in the SDLXLIFF file.

4. Now close Microsoft Word and return to SDL Trados Studio 2011.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/XLIFF_File_Format.htm
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Saving the Translation in the Original Document Format
Finally you save the file back to its native format, here Microsoft Word. To create a DOC file from our 
SDLXLIFF document, take the following steps:

1. Select the menu command File -> Save Target As.

2. This opens the Save Target As dialog box.

3. Select a location to save your target file.

4. In the text field File name the original file name, i.e. sample.doc has been entered 
automatically. If you want to save the translated file into the same folder as your original file, 
change the suggested name to e.g. sample_de.doc, so as not to overwrite the original file.

5. Click Save to confirm and save the target Microsoft Word file.

6. Now that you have finalized the translation, you can close the document in SDL Trados 
Studio 2011 with the File -> Close menu command.

FURTHER EXERCISES

In addition to the file you have translated in this chapter, the subfolder Translating Single Files contain an 
additional files that you can use for further training:

C answering_machine.ppt: an example of a Microsoft PowerPoint file

Use the features you have learned in this chapter to translate the sample file into your preferred target 
language.

SUMMARY

C When opening a file for translation you select the source/target language pair, the TM, an 
AutoSuggest dictionary and a termbase.

C Documents are translated in a side-by-side editor, which separates content from layout.

C When you have selected an AutoSuggest dictionary, relevant words and phrases are automatically 
suggested while you are typing. By pressing Enter you can insert these suggestions into your target 
segments.

C Repeated segments are translated automatically once you have translated and confirmed the first 
occurrence. This feature is called auto-propagate.

C The TM recognizes identical segments and translates them automatically by suggesting a 100% 
match.

C When a similar segment is found, a fuzzy match (e.g. a match of 79%) is suggested, which usually 
needs to be modified to fit the current context.

C Translations are entered into the target column on the right-hand side. By pressing Ctrl+Enter you 
confirm your translation, move to the next segment and store the translation in the TM.

C Pressing Ctrl+, opens a list of available character formatting options and/or tags, which you can 
insert into your target segment.

C Any terms that are found in the termbase (if available) are marked with a red bracket. The target 
terms can be easily inserted into your translation just by typing the first letter of the target term and 
by pressing Enter.
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C To view the document layout you can view the translation either in the native application (e.g. 
Word). Alternatively you can also open a preview window within Studio, which shows you the 
document layout while you are translating.

C During translation in Studio files are saved to an intermediary, bilingual exchange format called 
SDL XLIFF.

C When the translation is finished, you can generate the target document in its native format (e.g. 
Word).



Chapter

PROJECT PACKAGES

This chapter provides an example of how to translate files 
contained in a project package that has been sent to you by your 
client or agency. You will learn how to:

C Open a project package

C View an analysis report

C Use active term recognition

C Add comments

C Verify tags

C Deliver a return package

6
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WHAT ARE PROJECT PACKAGES?

Project packages are created by project managers using SDL Trados Studio 2011. Packages are compressed 
archives that contain the documents and resources required by translators, editors, proofreaders, etc. to 
complete a task, e.g.

C Source documents to translate (edit, proofread, etc.)

C Reference files

C Translation memories

C Termbases

C AutoSuggest dictionaries

Upon opening a project package the files contained therein are automatically extracted, and added to your 
SDL Trados Studio 2011 environment. The content of the package will appear as a new project in your list 
of projects. A project package file carries the extension *.sdlppx.

FOR MORE INFORMATION
V

C Overview: Working with Packages

C About Packages

OPENING A PROJECT PACKAGE

To open our sample project package take the following steps:

1. Click the Open Package button in the SDL Trados Studio 2011 toolbar. 

2. Browse to the sample files location and select the package file for your source/target 
language combination by double-clicking it, e.g. ....\Sample 
Files\Packages\Sample_Package_English-German.sdlppx.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Projects_View/Packages/P_Overview_Working_with_Packages.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Projects_View/P_About_Project_Packages.htm
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3. This will open the Open Package dialog box:

4. This dialog box displays, for example, project name, the due date (if any), the total and the 
untranslated number of words, the source files to translate contained in the package, etc. 

5. After taking a look at the information in this dialog box, click Finish to extract and import the 
package content. 

6. You will be prompted to select a folder into which the project files should be extracted. 
Browse for an empty folder, select it, and click OK to confirm.

NOTED
Please note that the folder you select here MUST be empty. If required you can use the Make New 
Folder button in the Browse for Folder dialog box to create a new, empty folder on the fly.
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7. Once the import is complete, click the Close button at the bottom right corner of the Open 
Package dialog box. 

8. After importing the package content SDL Trados Studio 2011 switches to the Projects view.�
The project that you have just imported from the package is shown in the Projects list.

FOR MORE INFORMATION
V

Overview: Open Package Wizard

VIEWING THE ANALYZE FILES REPORT

The sample project package contains an Analyze Files Report. This report provides useful information on 
the scope of the project, e.g. the total number of words, the number of repeated segments, the number of 
segments for which matches have been found in the TM, etc.

To view the report:

1. Click the Reports button on the bottom of the Navigation pane.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Ref/O-T/OpenPack/Overview_OpPWiz.htm
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2. The Analyze Files Report is now displayed on the right-hand side. Take a look at the table 
with the heading Totals. This section of the report gives you an overview of all the files 
contained in the package.

Analyze Files Results
Read the Totals from bottom to top:

C The last (Total) row in the above example displays the total number of segments (22) and words 
(233). 

C The row New shows the number of segments and words for which no TM matches have been 
found.

C In the rows above New you find the number of segments and words for which fuzzy matches have 
been identified. 

C The row 100% shows the number of exact matches. 

C The row Context Match shows the number of segments for which so called context matches have 
been found in the TM. These are segments for which a 100% match has been found in the TM and 
which are preceded by the same segment as the segment from the TM. This is why context matches 
are considered even more reliable than 100% matches. 

C Repetitions shows the number of segments for which no 100% TM match has been found, but 
which are repeated within the document(s). 

FOR MORE INFORMATION
V

Analyze Files Report Layout

VIEWING THE FILES IN THE PACKAGE

Click the Files button on the Navigation pane.

The package that you have just imported contains two files, a Microsoft Word and a Microsoft PowerPoint 
document, which have already been saved to the Studio-internal SDLXLIFF format.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Reports/Analyze_Report_Layout.htm
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For each file the total number of words is shown in the column Words. A Progress bar indicates whether 
a file has pre-translated content. In the above example, the Microsoft PowerPoint document has been 22% 
pre-translated by the person who sent you the package.

SELECTING A DOCUMENT FOR TRANSLATION

To start translating the document SamplePhotoPrinter.doc.sdlxliff double-click the file name. This will open 
the document in the Editor view. 

In addition to the files to translate the sample project package also contains a TM, a termbase, and an 
AutoSuggest dictionary. These databases have been automatically added to the project upon opening the 
package, and will be used when you translate the files.

Context Matches
Click inside the first segment, which will insert a translation from the TM. This time you get a so-called 
context match, which is indicated with a green CM icon in the translation status column. You can also see 
that the translation is confirmed. 

A context match is better than a 100% match. To be a context match, the translation memory segment 
must be a 100% match for the document segment and the two segments must have the same document 
context. For the document segment and the translation memory segment to have the same context, they 
must both have been preceded by the same segment.

In the example a Context Match is retrieved, as the TM ’knows’ that in a previously translated document 
this segment was also found at the beginning of the document.

FOR MORE INFORMATION
V

About Translation Memory Matches

Choosing from Several TM Matches
Move down to the next segment. For this segment, a 91% fuzzy match has been found in the TM. Take a 
close look at the Translation Results window. You will notice that there are actually two possible TM 
matches, i.e. a 91% and an 81% match: 

By default, SDL Trados Studio 2011 always suggests the highest match. You can switch between the TM 
matches by clicking the Select Next Match and Select Previous Match buttons. This will highlight the 
selected match in the Translation Results window and insert the corresponding target segment into the 
target cell. 

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTMsAbout_Translation_Memory_Matches.htm
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Modify the selected translation to fit the current source segment, then confirm it with Ctrl+Enter to move 
to the next segment. For the next segment, the TM has suggested a high fuzzy match. Linguistically the 
suggested translation is correct, but it lacks some character formatting. Apply the required character 
formatting (bold and italics) by marking the text in the target segment that needs the formatting, pressing 
the shortcut key Ctrl+, and selecting the appropriate formatting from the QuickPlace list.

Then confirm the modified translation and move to the next segment.

Active Terminology Recognition
Some words in the source segments are highlighted with red bracketed lines to indicate that they have 
been found in the termbase (i.e. photo printer and color cartridge). Note that the termbase is part of our 
sample project package, and was deployed to your PC when you opened the package.

1. Start translating the current segment, for which no TM match has been found.

2. As soon as you start typing the first letters of the target term for photo printer, a list opens, 
and suggests possible translations, e.g. Fotodrucker for photo printer.�

In the above example the same translation is suggested from the AutoSuggest dictionary 
(the suggestion marked by the green/yellow icon) and from the termbase (the suggestion 
marked by the gray icon).

3. You can click any of the suggestions to insert the target term into your translation.

4. You may also use another way of inserting the target terms from the termbase: the second 
recognized term in the current segment is color cartridge. To insert the target term into your 
translation use the shortcut key combination Ctrl+Shift+L.

5. This will open a list with all termbase suggestions (and only termbase suggestions) relevant 
for the current segment. Click the target term for color cartridge in the list (i.e. Farbpatrone) to 
insert it into your translation.

FOR MORE INFORMATION
V

C Term Recognition Window

C Working with Termbases

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/TermRecWin.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/Terms/EVWorkingwithTerminologyOverview.htm
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Displaying the Full Termbase Entry
Sometimes it can be useful to view the entire termbase entry rather than only the source and target term. 
To do this take the following steps:

1. In the Term Recognition window select one of the displayed source or target terms.

2. Right-click the selected term and select View term detail from the context menu.

3. This will open the Termbase Viewer window, which displays the full entry and an 
alphabetically sorted list of some other terms on the left-hand side.
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4. A termbase entry can contain a lot more information than just the terms in the different 
languages. Click the term ContraPLUS to view the full entry content.

5. This is an example of a termbase entry that includes additional information such as 
definitions, graphics, etc. 

Adding Terms on the Fly
Besides inserting terms from the termbase into your target segments, you can also add new terms from 
the document to the termbase. Example: the word paper has not been found in the termbase. To add it to 
the termbase, take the following steps:

1. Highlight the word paper in the source segment by double-clicking it.

2. Highlight its equivalent in the target segment (e.g. Papier).

3. While both words are highlighted click the right mouse button on one of the highlighted 
terms.

4. Select Add New Term from the context menu.
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5. A draft entry is now displayed in the Termbase Viewer window. Click the Save this Entry 
button to save the new entry in the termbase.

Close the Termbase Viewer window, if you need more space on the screen for your translation work. 
Confirm the finished target segment with Ctrl+Enter. When you move to the following segment note that 
the term paper is now highlighted with a red bracketed line. This means that you can click the shortcut key 
combination Ctrl+Shift+L to open a list of available target terms, among which you will find the translation 
for the newly-added term paper.

FOR MORE INFORMATION
V

How to Add Terms to a Termbase

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/Terms/EVTermbaseActionsAdd_Terms_to_a_Termbase.htm
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Inserting Tags
Now we translate segment number 5, for which there is no TM match. It contains a string enclosed in a 
bookmark start and end tag pair. In one of the previous chapters you already learned how to insert tags into 
the target segment by clicking them in the source segment with the Ctrl key pressed.

To insert the tags using the keyboard, take the following steps:

1. Start translating the segment and stop just before you translate the English word clearance, which is 
enclosed in bookmark start/end tags.

2. Press the Ctrl+, on your keyboard. This opens a list of possible tags to place at the current 
cursor position. 

3. Select the entry <bookmarkstart name=“clearance“/> from the list.

4. Type the target equivalent for clearance, press Ctrl+, again and select the <bookmarkend 
name=“clearance“/> tag from the list to insert the second tag into your translation by 
pressing the Enter key.

5. Finish translating the segment and confirm it with Ctrl+Enter to continue.

Interactive Tag Verification
The next segment also contains a bookmark start/end tag pair:

Intentionally leave out both tags, and confirm with Ctrl+Enter to see what happens.

As soon as you confirm the translation a red Error icon will be displayed between the source and target 
segment. 

Move the mouse pointer over the icon. This will display the reason for the error in a tooltip. In the above 
example, you are being warned that you left out both bookmark tags.

Go back to the segment (e.g. with the Up Arrow key on your keyboard) and insert the tags using the Ctrl+, 
keyboard shortcut. Then confirm the segment again.
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The interactive tag verification is triggered when you confirm a segment. How does SDL Trados Studio 
2011 react when you neglect to insert tags, and you do not confirm the segment? Give it a try with the next 
segment, which contains a field tag:

Translate the segment without inserting the tag. Then move to the following segment without confirming 
it, i.e. simply use the Down key to continue. Observe that although you left out the tag, no warning icon 
appears when moving to the next segment, i.e. the interactive tag verification is only triggered when you 
confirm a translation. 

You can also run a tag verification on the entire document, i.e. also on unconfirmed segments. We will 
have a look at this type of verification later, when you have finished translating the document.

For now, translate and confirm the next segment, which consists of a single word (i.e. ventilation). Then 
go to the following segment (Connecting and turning on the power).

FOR MORE INFORMATION
V

C Tag Verification

Adding Comments
You can add comments to particular segments or expressions/words in your translation (not to the source 
language segments). This is useful e.g. when you want to:

C Flag a translation that you need to check on later

C Provide information for the reviewer, proofread, project manager, etc.

To add a comment, take the following steps: 

1. Translate segment 9, i.e. Connecting and turning on the power.

2. Select a word in your translation, e.g. by double-clicking it.

3. Right-click the highlighted word. From the context menu select Add Comment.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Ref/U-Z/Options/File_Types/GTVS.htm
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4. In the text area of the Add Comment dialog box enter the comment text, e.g. Ask Dave 
whether this is correct. Then click OK.

5. After adding the comment the selected word is highlighted. When you move the mouse 
pointer over the highlighted string, the comment text (including the name of the user who 
added the comment as well as the date/time) is displayed in a tooltip.

Confirm the segment with Ctrl+Enter, and continue translating the following segments. Let us add 
another comment, this time not to a particular string, but to the segment as a whole:

1. After translating the segment, make sure that no particular word is selected.

2. Right-click anywhere inside the segment and select Add Comment from the context menu.

3. Enter the comment text into the Add Comment dialog box, then click OK.

4. This time the whole segment content is highlighted.

You can also edit existing comments by right-clicking the commented expression/word or segment. Select 
Edit Comment from the context menu. In the Edit Comment dialog box click Edit to edit an existing 
comment text. With Add you can add another comment to the same segment or expression/word.

TIPE
If a comment applies to the whole document rather than to a particular string or segment, select 
Current File from the Scope dropdown list before adding the comment.
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Commented segments and expression/words are highlighted and therefore easy to spot. However, if you 
want to see all comments in a document (or several open documents), click the Comments tab.

For each comment you will see the comment text, the name of the document the comment was found in, 
the date/time, etc.

C Edit Comments

C Comments Window

Copy Source to Target
Continue translating the remaining segments, i.e. segments 12 - 21. The last segment (21) says: �
•  2009 SDL International. This segment actually does not need to be translated. It can be pasted into the 
target cell. Rather than relying on the Windows clipboard (i.e. copy/paste), you can use the Copy Source to 
Target button located at the top of the Translation Results window. 

Click this button to duplicate the source segment into the target cell. (The default keyboard shortcut is 
Ctrl+Ins.) Then confirm the segment with Ctrl+Enter.

The Copy Source to Target function is highly useful for target segments that are identical or very similar 
to their source-language counterparts, e.g. sentences that contain a lot of untranslatable product names.

Display Filtering
Suppose you have finished translating the entire document, and you would like to take a particular look at 
all segments that have comments. To show only specific segments, take the following steps:

1. Select the menu command View -> Toolbars -> Display Filter.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/Comments_Window.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Ref/A-G/Edit_Comments_dialog_box.htm
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2. This will display an additional toolbar in SDL Trados Studio 2011.

3. From the Display dropdown list select Segment Review -> With comments.

4. The Editor now displays only segments with comments, regardless of whether the 
comments were added to a selection or to the whole segment. This is useful, for example, if 
you want to focus on the commented segments during proofreading. 

When you have checked on a commented segment and found it to be correct, you will certainly want to 
delete the comment:

1. Select the comment to delete in the Comments window.

2. Click the Delete Comment button.

3. This removes the comment from the list and, of course, also from the corresponding 
segment.
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To display all segments again, goto the Display dropdown list (in the Display Filter toolbar) and select 
General -> All segments. Make sure all segments in the current document are translated and confirmed. 
Save the document with the menu command File -> Save.

NOTED
Comments that were added to a document rather than a word/phrase or segment can only be viewed 
in the comments window.

NOTED
Comments added in SDL Trados Studio 2011 will not be part of the actual target document in the 
native format.

FOR MORE INFORMATION
V

About Filtering Segments

Running Tag Verification on the Whole Document
After translating a document you should run a tag verification on the entire text. To start a tag verification 
on the entire document take the following steps:

1. From the Tools menu select Verify.

2. If tag errors are found, they will be listed in the Messages window, which will be displayed 
instead of Translation Results.�
In the above example a missing field tag has caused an Error message. 

3. Double-click the message to jump to the segment in which the problem has been found.

NOTED
There are three different message types:  
Errors (red) are serious problems, which can in a worst-case scenario even prevent you from saving 
the translation back in its native format.  
Warnings (yellow) point to problems that might, for example, lead to a loss of formatting, 
bookmarks, etc., however, that usually do not prevent you from saving the translation in its native 
format.  
Notes (white) usually point to cosmetic issues such as missing spaces around tags.

4. Insert the missing tag into the highlighted segment, and confirm it with Ctrl+Enter, which 
will remove the Error message from the list. 

5. Save the file again. For this you can also use the keyboard shortcut Ctrl+S.

FOR MORE INFORMATION
V

Messages Window

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/EV_About_Filtering_Segments.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/Messages_Window.htm
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Selecting the Second File in the Package
Remember that the project packages also contains a small Microsoft PowerPoint file. To switch to the 
second document take the following steps:

1. Click the Files View button in the Navigation pane

2. Note that in the file list the progress for the Microsoft Word document is at 100%, (provided 
that you translated and confirmed all segments). Double-click the file 
SamplePresentation.ppt.sdlxliff to open it in the Editor view.

The sample presentation is very easy to translate, as it contains only two segments, which are both context 
matches. This is because they occur in exactly the same order in the Microsoft Word document that you 
previously translated.

Note that as you did not close the previous document, its name is still being shown in a tab in the Editor 
view. You can quickly switch back to the first document by clicking the corresponding tab.

In SDL Trados Studio 2011 you can have several documents open at the same time. This can be useful, for 
example, if you want to quickly check on the translation in a previous document.

Save the sample presentation by using the File -> Save command.
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CREATING AND SENDING THE RETURN PACKAGE

After finishing the translation you send back the package to the project manager in the form of a return 
package. Return packages (like project packages) are compressed archives that contain the translated, 
edited, or proofread documents. To create the return package, take the following steps:

1. Click the Project View button to open the Project view.

2. Right-click the PhotoPrinter Manual project and select Create Return Package from the 
context menu.
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3. The Progress bars in the Create Return Package dialog box show the translation progress for 
each file. They should be at 100%. Click Next to continue.
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4. Click Browse and select the location for the return package and the file name. Enter 
Photo_Printer_target.sdlprx as return package name. Note that return packages have the 
extension *.sdlrpx, which is added automatically to the file name. In the Comment text field 
you can enter an optional message for the recipient of the package (i.e. the customer or 
project manager).
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5. When the return package has been created you can send the return package by clicking the 
Send Package by Email button.

6. This will automatically create an email using Microsoft Outlook (if available), and add the 
return package as an attachment.

7. You can also choose to click the Open Target Folder button. This will launch Windows 
Explorer, where you can view the file, attach it to an email, upload it to an FTP server, etc.

8. Last, click Close to close the Create Return Package dialog box.

FOR MORE INFORMATION
V

C How to Return Completed Work in a Return Package

C Create Return Package Wizard > Creating Return Package

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Projects_View/Packages/P_Create_a_Return_Package.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Ref/A-G/CreateRePack/CreateRP_Creating.htm
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Marking the Project as Complete
Make sure that you are still in the Project View. Note that the project, which you initially imported from 
the project package, is still shown as In Progress in the Status column.

For good measure, mark the project as complete. When you are dealing with multiple projects this will 
help you see at a glance which projects are completed, and which ones are still in progress.

1. Right-click the project name in the Projects View, and select Mark as Complete from the context 
menu.

2. Confirm by clicking Yes.

Note that the Status column now shows Completed for the sample project.

SUMMARY

C Project packages contain the translatable files, project translation memories and possibly further 
elements such as reference files, termbases, etc.

C When opening a project package in Studio the package content needs to be extracted to an empty 
folder.

C The project package contains a file analysis reports, which gives an overview of the total number of 
words, the repetition and the TM leverage rate, etc.

C You can view the translatable project files in the Files view. From there you can open the files for 
translation by double-clicking them.

C After finishing the translation you create a return package, which contains the translated files, and 
which can then, for example, be e-mailed to the customer/project manager.



Chapter

USER DEFINED SETTINGS

This chapter provides some information on customization 
options, like setting your preferred language pair or specific 
fonts. for viewing your translation. 

You will learn how to:

C Set the default language pair, so that whenever you open 
a file for translation, the language pair is already set 
correctly.

C Customize the font size for viewing files in the editor.

C Select the colors used in the translation results window 
for marking differences between match from the TM and 
segment in the editor.

7
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CUSTOMIZATION

As you can customize the layout of the windows in SDL Trados Studio 2011, you can also customize how 
text is shown in the editor or how differences between a match from the TM and the segment in the editor 
are marked. 

Setting the font size for the editor
1. Select the menu command Tools -> Options, to go to the general settings for SDL Trados Studio 

2011

2. Select Editor and click on the small plus symbol to expand the list of options for the editor.

3. Select Font Adaptation from the list to view all possible settings

4. Activate the Adapt Font sizes checkbox and select for example the minimum font size for 
text in the source column.

5. Changing the font size might become necessary, if the text in the source document is not 
readily readable with a font size of 8 point. 
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6. SDL Trados Studio 2011 will by default try to show the formatting in the side-by-side editor 
in the same way as it is in the actual source document. This way, commonly used formatting 
like bold, underlined or italics will be shown as such and not through tags surrounding the 
words. If you want to switch to another view, select the Editor option and choose another 
setting form the Formatting display style drop-down menu

7. Select Language on the left-hand list and set the default source and target language you want 
to use whenever you translate a single document.
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8. Select Translation Results Window on the left-hand side and choose the colors that should be 
used to mark added or deleted words in the TM matches.

NOTED
If you change a setting in the Options dialog, SDL Trados Studio 2011 will remember this setting until 
you change it again, i.e. for every project you work on after customizing you settings, this settings will 
be applied.



Chapter

ALIGNMENT

This chapter provides an example of how to process existing 
source documents and their translations through alignment. 
An alignment allows you to import translated legacy content 
into a translation memory. You will learn how to:

C Set up an alignment project

C Review the alignment result

C Import the alignment result into a TM

8
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WHAT IS ALIGNMENT?

Alignment is a process that allows you import existing translations into a TM. Imagine that you have an 
English source file and the corresponding target document, but the content is not stored in a translation 
memory database, as the translation was done without a TM system. Alignment allows you to pre-process 
both the source and the target file(s), so that you can import the legacy content into a TM. The aligned 
content can then be leveraged for future translation projects. SDL Trados Studio 2011 uses the SDL 
WinAlign component to process legacy source and target documents.

The main challenge during alignment is to determine whether segments or entire paragraphs were left 
out during translation. Sometimes content is left out, because it is not relevant for the target audience. 
Also, translators often change the segmentation, e.g. by combining two source segments into one. 
Although WinAlign uses a sophisticated algorithm to detect such discrepancies between the source and 
the target text, it is recommended that you review the alignment result.

The exercise in this chapter involves a scenario in which an English source document needs to be aligned 
with its translation. The sample files for this exercise can be found in your sample files folder, i.e. ..\Sample 
Files\Alignment.

SETTING UP AN ALIGNMENT PROJECT

Creating an Alignment Project
To create an alignment project take the following steps:

1. On the Home screen of SDL Trados Studio 2011 click the Align Translated Documents toolbar 
button.
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2. This opens the SDL WinAlign application.

3. In SDL WinAlign select the File -> New menu command.

4. In the New WinAlign Project dialog box make sure that English (United States) is selected as 
source language. Note the source sample file is in English.
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5. Click the Target Language button to select your target language from the list, i.e. German 
(Germany) from the list, then confirm by clicking OK.

6. From the File Type dropdown list select Microsoft Word Documents (*.doc), as the sample 
files to align are in Microsoft Word (DOC) format.

7. The dialog box should now look as shown below. Click the Files tab to proceed.
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Selecting the Files to Align
1. On the Files tab click the Add button in the lower left part of the dialog box. Then browse to your 

sample files location and select the source document, i.e. Eng01.doc by double-clicking it.

2. Repeat this procedure to select the target file, i.e. click the Add button on the right-hand side 
of the dialog box and pick the sample file for the selected target language, i.e. Ger01.doc.
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3. Then click the Align File Names button. Note that a line is drawn between the two selected 
files, which now form a file pair.

Configuring the Export Settings
1. Click the Export tab and select the Translation Memory Exchange Format (TMX) radio button.

2. Then activate the Export as TMX 1.4 check box.

3. Now click OK to close the New WinAlign Project dialog box.
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RUNNING THE ALIGNMENT PROCESS

1. To run the alignment process select the Alignment -> Align File Pair(s) menu command.

2. Wait a few seconds for the alignment result to show be displayed, and which should look as 
shown below:

NOTED
At this point you can check the alignment result segment by segment and make changes and 
corrections if necessary. However, this is not covered in this chapter. We simply assume that the 
alignment is correct, and go on exporting the result.

EXPORTING THE ALIGNMENT RESULT

We will now export the alignment result to a TMX file, which you can then import into an SDL Trados 
Studio 2011 TM. To do this take the following steps:

1. Select the File -> Export File Pair menu command.
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2. In the Export File Pair to File dialog box browse to the location for your export file. Take a 
folder that you can find and access easily, e.g. your desktop. You can accept the suggested file 
name (e.g. Eng01.tmx) by clicking Save to run the export.

3. Wait a few seconds for the export to finish. You should now see the TMX export file on your 
desktop.

CREATING A TRANSLATION MEMORY (TM)

Now we will create a new TM into which we will import the alignment result. Take the following steps:

1. Switch to SDL Trados Studio 2011 and click the New Translation Memory toolbar button.

2. This opens the New Translation Memory dialog box. Enter the name of your TM into the 
Name text field, e.g. Sample EN-DE.

3. Make sure that the source and target language selected here matches the language pair from 
the alignment project. Then click Finish to create the TM file.

NOTED
Note the location in which the TM file is going to be created. You can change it by clicking the Browse 
button and selecting another folder.
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4. Click the Finish button, then wait for the TM creation to complete. Finally, click Close.

5. The application now switches to the Translation Memories view, where your new TM is 
shown in the top left corner.

IMPORTING THE ALIGNMENT RESULT INTO THE TM

Now you can import the alignment result into a TM by following the steps below:
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1. Right-click the TM and select the Import command from the context menu. This opens the Import 
dialog box.

2. In the Import dialog box click the Add Files button and select the Eng01.tmx file, which you 
previously exported from SDL WinAlign. Then click Next to proceed.
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3. You can leave the TMX import options on the next page unchanged. Just click Next again. 
On the following page click Finish to start the import.

4. Wait a few seconds for the import process to complete, then click Close.

5. The import result is shown in the Translation Memory view. The TM is no available for 
future translation projects.

FOR MORE INFORMATION
V

C Import Wizard Overview

C Importing and Exporting Translation Memory Data

SUMMARY

C SDL WinAlign generates TM content from existing source documents and their translations 
through a process called alignment.

C In SDL WinAlign you pair up the files to align. Alignment is an automatic process.

C The alignment result can be reviewed and corrected if required.

C The alignment result is then exported to a TMX (Translation Memory eXchange) file.

C The export file can then be imported into a new or into an existing TM.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Ref/H-N/Import_Wizard.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/TM_View/TM_Data/Importing_Exporting_TM_Data/O_ImExpTM.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Ref/H-N/Import_Wizard.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/TM_View/TM_Data/Importing_Exporting_TM_Data/O_ImExpTM.htm


Chapter

GENERATING AUTOSUGGEST 
DICTIONARIES

In this chapter you will learn how to:

C Create an AutoSuggest dictionary from a TM export file 
in TMX format

9
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GENERATING AN AUTOSUGGEST DICTIONARY

AutoSuggest dictionaries offer for segment fragment matching for increasing translation productivity. 
AutoSuggest dictionaries intelligently suggest segment fragments that fit the current context while you 
are typing.

AutoSuggest dictionaries are created from existing translation memories. The TM input files can be in one 
of the following formats:

C *.sdltm

C *.tmx (Translation Memory Exchange)

C *.tmx.gz (compressed TMX format)

For this exercise we provide a TMX sample file, which you can find in your sample files folder. i.e. 
..\Sample Files\Generating AutoSuggest Dictionaries.

To create an AutoSuggest dictionary from an existing TMX file, take the following steps:

FREELANCE
T

AutoSuggest dictionaries can only be created with the Professional or Freelance Plus Edition of SDL 
Trados Studio 2011. With the Freelance Edition you can use AutoSuggest dictionaries, but you can 
only create them within the first 30 days after installation of the product.

1. Select the Tools -> Generate AutoSuggest Dictionary menu command.

2. This opens the New AutoSuggest Dictionary dialog box. Here, click the Browse button to 
select the TMX input file.

3. In the Open File-based Translation Memory dialog box, make sure that the file type TMX 
Translation Memories (*.tmx;*.tmx.gz) is selected in the file type dropdown list.

4. Browse for the sample TMX file from which the AutoSuggest dictionary is to be created, i.e. 
Sample EN-GB_DE-DE.tmx.
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NOTED
The sample file is an English-German TM in TMX format that contains approx. 40,000 TUs.

5. Click Next and wait a few seconds for the TMX file to load.

6. On the next page you can see the language pair of the AutoSuggest dictionary (i.e. English - > 
German). Just click Next to continue.
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7. On the page AutoSuggest Dictionary Creation Memory Usage the total number of units to 
process is displayed. The sample TMX file contains over 40,000 units. You may decide to 
reduce the number of units to process. Reducing the number of units to process can be 
helpful when processing very large TMs, which could help avoid memory issues. However, 
for our sample input file this is not required, as it is relatively small. Therefore, just click 
Next to continue.

8. On the following page click Browse and select the location in which the AutoSuggest 
dictionary is to be created. Select a location that you can find easily, e.g. your desktop, and 
enter a name for the AutoSuggest dictionary file, e.g. EN-DE. 

NOTED
AutoSuggest dictionary files have the extension *.bpm (for bilingual phrase mapping).

9. Click Finish to start the creation of your AutoSuggest dictionary. Depending on the size of 
the TMX file, generation of the AutoSuggest dictionary takes some time (for the sample file 
about 3 minutes).

NOTED
The AutoSuggest dictionary can only be generated, if your input TM contains 25,000 translation units 
or more. TMs with less units do not provide a sufficient basis for reliable phrase extraction.

10. When the generation process is complete, click Close. Open Windows Explorer to view the 
newly-created AutoSuggest dictionary file, e.g. EN-DE.bpm.

FOR MORE INFORMATION
V

How to Create an AutoSuggest Dictionary

SUMMARY

C AutoSuggest dictionaries support the translation process by interactively suggesting relevant words 
and expressions while you are typing.

C AutoSuggest dictionaries can be generated from a TM or a TM in TMX export format.

C The source TM needs to contain at least 25,000 units (i.e. pairs of source and target segments) for 
meaningful phrase extraction.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/A_ASDict.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Setting_Preferences/AutoSuggest/Schedule_TM_Phrase_Extraction.htm


Chapter

CREATING TERMBASES FROM 
EXCEL GLOSSARIES

In this chapter you will learn how to:

C Convert a glossary file in Excel format into an SDL 
MultiTerm termbase

17
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ABOUT CONVERTING EXCEL GLOSSARIES

SDL MultiTerm comes with an additional product called SDL MultiTerm Convert, which allows you to 
convert, for example, Excel glossaries to SDL MultiTerm XML format. This XML format then be imported 
into a termbase.

PREPARING YOUR GLOSSARY FOR CONVERSION

In your sample files folder, i.e. ..\Sample Files\Converting_Glossaries, you find the glossary.xlsx sample file. 
When opened in Microsoft Excel the glossary looks as shown below:

Note that this file already fits the requirements for converting into SDL MultiTerm XML format, i.e.:

C The terms for each language and the values of the descriptive field (i.e. Subject) are listed in separate 
columns.

C The column headers contain the label of each index field and the descriptive field. It is important 
that the column headers match the names that the fields will have in the SDL MultiTerm termbase.

CONVERTING THE MICROSOFT EXCEL FILE

Specifying the Input Format and File
To convert the Microsoft Excel glossary take the following steps:

1. First, make sure that the file to convert is NOT open in Microsoft Excel.
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2. Launch SDL MultiTerm Convert through Start -> All Programs -> SDL -> SDL MultiTerm 
2011. Then click the SDL MultiTerm 2011 Convert application icon.

3. This will open SDL MultiTerm Convert, which is a wizard application. On the first page of 
the wizard, click Next to continue. On the following page click Next again.

4. On the Available conversion options page select Microsoft Excel format from the available 
input formats, then click Next.
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5. On the Specify Files page you select the file to convert. Click the Browse button and select 
the file glossary.xsls from your sample files location (i.e. ..\Sample 
Files\08_Converting_Glossaries) by double-clicking it. Then click Next.

NOTED
The other text fields will be filled in automatically. These contain the names of the output file paths, 
most importantly the XML output file, which we will later import into a termbase.

Specifying the Termbase Fields
1. On the Specify Column Header page, the field names from the column headers in the selected Excel 

file are shown in the Available column header fields list. On this page you need define which 
column headers should be processed as index fields (i.e. languages), and which ones contain 
additional (descriptive) information. 

2. Start with the Subject field. Make sure that this field is highlighted in the Available column 
header fields list. 
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3. The Subject column contains descriptive information (i.e. no terms), therefore the 
Descriptive fields radio button, which is already pre-selected, applies here. Just change the 
value in the dropdown list below from Text to Picklist.

NOTED
The data type Text is used for fields that allow for free text, e.g. a definition, note, example, etc. When 
you have a limited number of values (e.g. only a limited number of clients), then use the data type 
Picklist. This is the likely data type for Subject, as a Subject is usually associated with a limited set of 
values, e.g. general, politics, science, etc.

4. Continue with the other columns, i.e. English and German. Let us assume that the terms 
listed in the English column should be stored as English (United Kingdom) in the termbase. 
To do this make sure that English is selected in the Available column header fields list.

5. Then click the Index field radio button, as English is an index field (i.e. a language), not 
descriptive information.

6. From the dropdown list below Index field select English (United Kingdom).

7. Repeat the above step for German, which needs to be assigned to German (Germany). 



Crea t ing  Te rmbases  f r om Ex ce l  G lossa r ies10

10-6     SDL TRADOS STUDIO 2011 GETTING STARTED FOR TRANSLATORS
SDL plc Confidential. Copyright ¤�2011 SDL plc.

8. Click Next to continue.

Specifying the Entry Structure
1. Descriptive information can be assigned to the entry level (i.e. the top level), if they refer to the entry 

as a whole, i.e. to all terms contained in the entry. Descriptive fields can also be assigned to the term 
level, if they refer only to a particular term. Let us assume that the Subject field value should always 
refer to the whole entry.

2. Highlight Subject in the Available descriptive fields list and select Entry level in the Entry 
structure box. Then click the Add button.

3. Note that the Subject field has now been added under Entry level and therefore above the 
languages. Click Next to continue.
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Starting the Conversion
1. On the Conversion settings summary page click Next.

2. This will start the conversion. Wait for the progress bar to indicate that the conversion is 
finished. 

3. Proceed by clicking Next and then click Finish.

4. Take a quick look at the sample folder that contains your glossary.xslx file. �
SDL MultiTerm Convert has created the following files:

C glossary.xdt: this is the termbase definition file from which we will create a new (empty) 
termbase

C glossary.mtf.xml: this is the termbase content, which we will import into the termbase (which 
we are going to create in the next step)

FOR MORE INFORMATION
V

About SDL MultiTerm Convert

CREATING A NEW TERMBASE

Start SDL MultiTerm if it is not running through Start -> All Programs -> SDL -> SDL MultiTerm 2011 -> 
SDL MultiTerm 2011 Desktop.

Creating the Termbase File
To start creating the new termbase take the following steps:

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/SDL_MultiTerm_Convert/About_MultiTerm_Convert.htm
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1. Select the Termbase -> Create Termbase menu command.

2. This opens the Save New Termbase dialog box, in which a location and a default name for 
the new termbase is already suggested, i.e. New Termbase.sdltlb.

3. Replace the suggested termbase file name with glossary.sdltb, then click Save.

Loading the Termbase Definition
1. This opens the Termbase Wizard. On the first screen of the wizard just click Next to continue.

2. We will now create the new termbase based on the glossary.xdt termbase definition, which 
SDL MultiTerm Convert has created. To select this termbase definition click the Load an 
existing termbase definition file radio button.

3. Click the Browse button and select the file glossary.xdt from your sample files location. 

4. Then click Next to continue.
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Naming the Termbase
1. On the Termbase Name page, enter a name for your termbase into the Friendly Name text field, e.g. 

User Interface Glossary. 

2. Then click Next to continue.

Languages and Descriptive Fields
1. The Index Fields page lists the indexes (i.e. languages) taken over from the Excel file. Here you just 

need to click Next to continue.

2. You can also skip the next two pages, i.e. Descriptive Fields and Entry Structure by clicking 
Next twice.
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3. On the Wizard Complete page click Finish to create the termbase.

4. Wait a few seconds for the new termbase to be created. Note that the termbase name is 
shown in the application title bar.

FOR MORE INFORMATION
V

About Creating Termbases

Importing the Glossary Content
Note that the newly created termbase is still empty. You need to import the content that you converted 
from the Excel glossary into the termbase. To do this take the following steps:

1. Click the Catalog button on the bottom of the Navigation pane.

2. Right-click Import and then select Process from the context menu.

3. On the first page of the Import Wizard click Browse and select the file glossary.mtf.xml, 
which has been created by SDL MultiTerm Convert, from your sample files folder.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Creating_New_Termbases/About_Creating_New_Termbases.htm
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4. Then activate the Fast import check box and proceed by clicking Next.

5. On the following page click Next again.

6. Wait for the progress bar to reach 100%. After all entries have been processed click Next, 
and then Finish.

7. The application should now switch to the Terms view, and the terms from the imported 
entries are now shown in the Browse list.

FOR MORE INFORMATION
V

How to Import Termbase Data

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Importing_Termbase_Data/Perform_a_Termbase_Entry_Import.htm
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SUMMARY

C Glossaries in Excel format can be converted to SDL MultiTerm XML through SDL MultiTerm 
Convert, which is a wizard application.

C The field and language names need to be stated in the first row, i.e. in the column headers.

C SDL MultiTerm Convert generates an *.xdt file, which contains the termbase definition and from 
which a termbase can be created.

C SDL MultiTerm Convert also generates an *.xml file, which contains the actual entries, and which 
can be imported into the termbase.



Chapter

INTERMEDIATE TOPICS -  
OVERVIEW

This chapter provides a quick overview of the topics covered in 
the Intermediate training course for SDL Trados Studio 2011.

11
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SDL Trados Studio 2011 Intermediate for Translators - Overview
The Intermediate training course covers the following topics:

C Processing multiple files through projects

C Automated project preparation

C Using multiple translation memories

C Find/replace functionality

C More on the display filter function

C Changing the segmentation on the fly (merging and splitting segments)

C Finalizing and completing projects

C Merging multiple files into one

C Reviewing documents (tracking changes)

C Selecting your preferred spell check module

C Automated quality assurance (QA Check)

C Automated terminology verification

C Fine-tuning the auto-propagate settings

C Customizing keyboard shortcuts
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